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There are large quantity of text, audio, video and other documents available on the internet, on about any 

subject. Search is one of the most important user interface elements in any large website. There are two ways of 
searching the information: (1) To us
Information retrieval (IR) is the process of gathering applicable information to a query. IR is different from data 
retrieval, which is about to find small amount of data in a databases
information is not structured; it is contained in free form in text or in multimedia content. 

There are many types of information retrieval they are: (1) Speech retrieval, which deals speech 
continuously transcribed manually by automated speech recognition (ASR). (2) Cross language revival uses a 
query in a language say English and perceive document in other languages like Chinese and Russian. (3) 
Question answering IR system, which retrieve answers from a body o
image on a theme. (5) Music retrieval, which finds a piece when a user hums a melody or enter the notes of a 
musical theme. 

Music is a widely enjoyed content type, existing in many multifaceted representations. With
information ere, a lot of digital music information has apparently available at the user’s fingertips. However the 
abundance of information is too wide
and human manner, motivating the development of Music Information Retrieval (Music
the fast growth of digital music collection and media replay on transferable devices, fruitful retrieval and 
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A B S T R A C T  
Music information retrieval (MIR) systems allow users to search collections of music. 
Surfing can be performed, for example, by means of metadata using keywords to 
describe music or the actual such that the melodic content of a musical piece. Music 
specification with respect to its scale is an emerging area in music information retrieval. 
A key problem in music specification is how to efficiently extract audio features for 
high level classification. Many types of features have been used for music classification 
including low level features such as timber and temporal features and mid
such as chord, rhythm, and beat for music analysis. Most present work in music 
information retrieval survey allows music via low-level features like Mel frequency 
cepstral coefficient (MFCC) and other spectral coefficients. Although, low
features are insufficient for many applications considering to the signal characteristics 
comparatively to the semantic content of music. On the contrary, mid
such as Chord sequence, which describes harmonic progression and tonal structure of 
music, is one of the most important mid-level features of music. With chord sequence, 
songs that are similar in various aspects can be identified and retrieved more 
effectively. This paper focus on chord recognition and its applications.

INTRODUCTION 

There are large quantity of text, audio, video and other documents available on the internet, on about any 
subject. Search is one of the most important user interface elements in any large website. There are two ways of 
searching the information: (1) To use a search engines. (2) To browse directories organized by categories. 
Information retrieval (IR) is the process of gathering applicable information to a query. IR is different from data 
retrieval, which is about to find small amount of data in a databases with a given structure. In IR systems, the 
information is not structured; it is contained in free form in text or in multimedia content. 

There are many types of information retrieval they are: (1) Speech retrieval, which deals speech 
ibed manually by automated speech recognition (ASR). (2) Cross language revival uses a 

query in a language say English and perceive document in other languages like Chinese and Russian. (3) 
Question answering IR system, which retrieve answers from a body of text. (4) Image retrieval, which finds 
image on a theme. (5) Music retrieval, which finds a piece when a user hums a melody or enter the notes of a 

Music is a widely enjoyed content type, existing in many multifaceted representations. With
information ere, a lot of digital music information has apparently available at the user’s fingertips. However the 
abundance of information is too wide-ranging and too various to compose, inspect and present in a consistent 

otivating the development of Music Information Retrieval (Music-
the fast growth of digital music collection and media replay on transferable devices, fruitful retrieval and 
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There are large quantity of text, audio, video and other documents available on the internet, on about any 
subject. Search is one of the most important user interface elements in any large website. There are two ways of 

e a search engines. (2) To browse directories organized by categories. 
Information retrieval (IR) is the process of gathering applicable information to a query. IR is different from data 

with a given structure. In IR systems, the 
information is not structured; it is contained in free form in text or in multimedia content.  

There are many types of information retrieval they are: (1) Speech retrieval, which deals speech 
ibed manually by automated speech recognition (ASR). (2) Cross language revival uses a 

query in a language say English and perceive document in other languages like Chinese and Russian. (3) 
f text. (4) Image retrieval, which finds 

image on a theme. (5) Music retrieval, which finds a piece when a user hums a melody or enter the notes of a 

Music is a widely enjoyed content type, existing in many multifaceted representations. With the digital 
information ere, a lot of digital music information has apparently available at the user’s fingertips. However the 

ranging and too various to compose, inspect and present in a consistent 
-IR) techniques. Due to 

the fast growth of digital music collection and media replay on transferable devices, fruitful retrieval and 



278                                                                   R.L. Jasmine et al., 2016 
Australian Journal of Basic and Applied Sciences, 10(2) Special 2016, Pages: 277-282 

 

management of music is needed in the digital era. Most current work in music information retrieval peruse 
music via low-level features however, low-level features are insufficient for numerous requisition since they are 
equivalent to the signal characteristics preferably than the semantic content of music. 

 

                                                   
 
On the perverse, mid-level characteristics for example as chord, rhythm, and instrumentation contain rich 

information for music analysis. Based on the information of the music some music oriented system is available 
such as last.fm, sheetmusicarchive.net, musicsheetplus.com, stagepass.com and pando. However such an 
approach suffers from drawbacks: (1) First a newly added music must be recognized. (2) Second unpopular 
music recordings may be recognized. Chord 
 
Research Background: 

A chord is a set of tones played simultaneously. A chord progression is a sequence of chords over time and 
is what describes the harmony of a piece (Mitchell, T.M., 2010). Automatic chord recognition is the process of 
extracting a chord progression from an audio file. These chord sequences are used by musicians as lead sheets 
summaries containing chords, melody, and lyrics as well as by researchers for tasks such as key detection, genre 
classification and lyric interpretation. Performing chord analysis by hand is time consuming, prone to human 
error, and requires two or more trained experts. 

sequence, which narrates characteristics series and tonal composition of music, is one of the most important 
mid-level features of music. Since music characteristics series is strongly related to distinguish sensation, alike 
chord succession can be noticed in songs that are adjacent in genre, emotion, etc. With chord sequence, songs 
that are similar in various aspects can be distinguished and retrieved more effectively. In this paper, a chord 
recognition method is proposed. 

This is what makes automatic chord recognition an important area of research (Schacht, A and W. Sommer, 
2009). The two main steps of automatic chord recognition are feature extraction and pattern matching. Feature 
extraction is the process of extracting useful information from audio files, and pattern matching is how chord 
labels are applied to that data. There are many challenges encountered by systems that process audio signals. 
There are background noises, percussion instruments and other unwanted tones in audio recordings. It is also 
difficult to distinguish when chords change and to line these points up exactly with the beat. Preprocessing helps 
eliminate unwanted information from the audio files before or during the feature extraction step, depending on 
the system. 

Existing perusal on chord identification is predominantly based on HMM (Possner, J., 2008). The general 
procedure is described as follows. First, the input audio is cleaved into successive frames and transformed to 
frequency domain. Then, feature vectors for chord identification are retrieved. Since chord are composed of 
harmony formed by multiple notes or pitches, the twelve dimensional pitch class profile 9PcP) feature vector or 
chroma vector, which represents the intensity of twelve semitone pitch class, is mostly used (Hu, X and J.S. 
Downie, 2010l; Upadhye, R and V.H. Sahasrabuddhe, 1992; Schacht, A and W. Sommer, 2009). Very little 
work has taken place in the area of applying techniques from computational musicology. The special work done 
by Sahasrabudha et al. (Ghias, A et al, 1995) gives the ability to identify raga in a melodic type of composition. 
The system was based on assigning a raga to is nearest seven note scale. The seven note scale, as is also the case 
in Western music, is considered a typical full scale. 
 
Proposed Architecture: 

The harmonic progression and tonal structure of music can be described by a chord sequence. Harmonic 
progression can interrupt chord sequence from which genre, emotion can be observed. With chord sequence, 
similar songs in various scales can be identified and retrieved more successfully. 
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Separation Of Audio From The Music: 

Imagine you are standing in a busy street among a crowd of people. You can glean traffic sound, footfall of 
people adjacent, the bleeping of a rambler crossing, your mobile phone ringing, and co-workers at the back of 
you having a conference. Even though all these different sound sources, you have a pretty good idea of what is 
going on around you. It is more than just a mess of overlapping noise, and if you try hard you can concentrate 
on one of these sources if it is important to you such as the conversation behind you. There are two main 
obstacles for their comprehensive acquisition determined on the scenario.  

The main limitation in some cases is: (1) High latency and computational cost. (2) In other cases the quality 
of the results is insufficient. Audio editing software is software which allows to manage and perceipitate of 
audio data. Audio editing software can be implemented completely or partly as library, as computer approach, as 
Web approach or as a loadable kernel module. There are different types of audio editing software they are: (1) 
Adobe Audition (2) AVS Audio Editor (3) Diamond Cut (4) Wave Lab (5) Music Maker  
 
Download and install AVS Audio Editor: 
Open An Audio File: 

To open an audio file that you intend to chop pop the Open button on the Home tab of the Ribbon 
Command Bar. 

 

 
 
Fig. 2: To open an audio file 

 
Select the Necessary Segments: 

To select the parts of your audio file that you need to have as separate files apply markers. Start by 
indicating the first segment: pop the required position within the Waveform. Display with the left mouse button 
and compress the Add Marker button on the Edit tab. The start of the file will be the beginning of the opening 
chunch and the added marker indicates its end. 

 

 
 

Fig. 3: Setting markers for the selected music 
 

Split Your Audio into Several Files: 
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As soon as all the required markers are set click the Split File by Markers link on the Edit tab. the audio will 
be split into various files according to the markers set. They will be called as the input file name + the sequence 
number and put the Files tab of the result and Filters panel.
 
Save the Resulting Tracks: 

To retain all the derived tracks utilize the Save All option of the File tab. If you do not need all the tracks 
double click the essential file at the result and Filters panel and use th
any designation, place, format which can suit your needs best.

 

 
Fig. 4: Saving the audio track. 
 
Representing the Chords Of Songs:

To represent the chords of a song is described briefly. A good representation 
and allow adaptable user interfaces and tools to be constructed. A song is a combination of different keys 
formed to make a tune. They are constructed by the pitch values of the notes. The occurrence of each note in the 
song is the duration of all notes including the chords.

 

Fig. 5: representation of chords in a song
 

Similarity Relations of Chords: 
The notes on the keyboard are given by comparing them to the notes of the alphabets. The keyboard notes 

can be named as c-d-e-f-g-a-b. Each note differs with each other in sound. The seven notes of keyboard repeat 
themselves again and again. That the notes sound the same but the pitch differs. For example if c note is played 
and moved to the right until it finds the next c,
standard semiprofessional music keyboard has forty eight keys. One of these twelve set of notes is technically 
called an octave. Western music is based on frequencies of the keys. An octave is
intervals such that the frequency ratio of two neighboring intervals is the same. This interval is called a semi 
tone. There are twelve mutually exclusive half notes in the system. In western music middle c octave that is also 
called the middle c scale etc. starts from the first white key set to 240 Hz. Once the octave is figured out, it is 
easy to identify the first key of this octave9set to 240 Hz. The below table give the frequencies of each scale.
 
Recognizing Chords: 

The basic of western music is the recognition of chords. If a tune stays in one key, then the basic chords are 
formed by the combination of different notes on the scale. Much song uses the three chords based on the basics 
(i), the quarter (IV) and the fifth (V). Sometimes a fourth note is added which is a third above the highest note of 
the triad. This gives a seventh chord. When a minor third is used it can result in the use of a note which is not 
actually part of the indegineousl scale. For sample, the C cons
G is Bb which is not part of the C major scale.
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formed to make a tune. They are constructed by the pitch values of the notes. The occurrence of each note in the 

is the duration of all notes including the chords. 

 
representation of chords in a song 

The notes on the keyboard are given by comparing them to the notes of the alphabets. The keyboard notes 
b. Each note differs with each other in sound. The seven notes of keyboard repeat 

themselves again and again. That the notes sound the same but the pitch differs. For example if c note is played 
and moved to the right until it finds the next c, both notes sounds the same but one is higher than the other. A 
standard semiprofessional music keyboard has forty eight keys. One of these twelve set of notes is technically 
called an octave. Western music is based on frequencies of the keys. An octave is dividing into twelve equal 
intervals such that the frequency ratio of two neighboring intervals is the same. This interval is called a semi 
tone. There are twelve mutually exclusive half notes in the system. In western music middle c octave that is also 
alled the middle c scale etc. starts from the first white key set to 240 Hz. Once the octave is figured out, it is 

easy to identify the first key of this octave9set to 240 Hz. The below table give the frequencies of each scale.

basic of western music is the recognition of chords. If a tune stays in one key, then the basic chords are 
formed by the combination of different notes on the scale. Much song uses the three chords based on the basics 

). Sometimes a fourth note is added which is a third above the highest note of 
the triad. This gives a seventh chord. When a minor third is used it can result in the use of a note which is not 
actually part of the indegineousl scale. For sample, the C considerable triad is CEG and a small third above the 
G is Bb which is not part of the C major scale. 
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Table 1: List of frequencies for notes 
A 440.00 HZ 
A# \ Bb 466.16 HZ 
B 493.88 HZ 
C 523.25 HZ 
C# \ Db 554.37 HZ 
D 587.33 HZ 
D# \ Eb 622.25 HZ 
E 659.25 HZ 
F 698.46 HZ 
F# \ Gb 739.99 HZ 
G 783.99 HZ 
G#\ Ab 830.61 HZ 
A 880.00 HZ 

 
 
The problem of finding the key piece of chord is called key finding. The method behind the key finding is 

that the frequencies of each key are compared. When a song matches a particular key the frequencies distance 
between the chords and the tone of the key are relatively small. The formula is given by: 
S = αr(I) + r(IV) + r(V) + (β if the �irst chord matched the key 
β if the �irst chord matched the key 

Here r denotes the scale of the key. A denotes the frequency of the other key in the scale; B supports the 
first and last key of the chord. 

                                  
Fig. 6: Tree structure of chord sequence 
 
Conclusion: 

A chord in an Indian music is a very complex structure. The sequence of notes used to play the songs is 
based on the chords. The proposed architecture aims to build the database so that it includes a large number of 
examples in each chord. The proposed system analyzes the sequence of scales for the chord identified. Here, it 
not only identifies the chords, but it also tags them according to their scales. The scope of the model can also be 
extended to mood based audio retrieval. The combination of audio and lyrical content is a crucial factor for 
future mood classification system. 
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